
  

KATEDRA TECHNIK WYTWARZANIA I AUTOMATYZACJI 

Przedmiot: Napęd i sterowanie maszyn 

Temat 
ćwiczenia: 

Napęd mechaniczny z silnikiem 

bezszczotkowym 
Numer ćwiczenia: 

2 

 

1. Cel ćwiczenia 

 

Celem ćwiczenia jest zapoznanie się z budową, zasadą działania oraz cechami 

charakterystycznymi układu serwonapędu z silnikiem bezszczotkowym stosowanych we 

współczesnych obrabiarkach CNC. Ponadto student może zapoznać się z nowoczesnymi 

układami sterującymi oraz ich możliwościami w zakresie kształtowania charakterystyki 

mechanicznej napędu poprzez dobór wartości wzmocnień układów regulacji położenia 

i prędkości. 

 

2. Przebieg ćwiczenia 

 

1. Uruchomić układ pod nadzorem prowadzącego ćwiczenia. 

2. Przeprowadzić konfigurację układu zgodnie z instrukcją stanowiskową. 

3. Wykonać procedurę najazdu na punkt referencyjny. 

4. Wykonać pomiary dokładności i dynamiki ruchu suportu dla podanych parametrów. 

5. Zmienić rodzaj regulatora. 

6. Wykonać pomiary dokładności i dynamiki ruchu suportu z jednoczesną rejestracją błędu 

nadążania. 

7. Zarejestrowane przebiegi zapisać na nośniku USB w celu sporządzenia sprawozdania. 

 

3. Wytyczne do opracowania sprawozdania 

 

Sprawozdanie studenci wykonują indywidualnie i samodzielnie. 

Sprawozdanie powinno zawierać: 

- datę ćwiczenia, grupę, imię i nazwisko osoby biorącej udział w ćwiczeniu, 

- schemat blokowy stanowiska laboratoryjnego, 

- dane wejściowe podane przez prowadzącego ćwiczenia, 

- wykres odpowiedzi układu na wymuszenie skokowe dla podanych wartości wzmocnień 

regulatorów położenia i prędkości, kształtu charakterystyki i wartości czasów rozpędzania i 

hamowania. 

- wnioski. 



 

Silniki BLDC 

BLDC. Nazwa ta wynika z angielskiego określenia brushless DC motor i jest powszechnie 

używana. Często też mówiąc o silnikach BLDC, używa się wyrażenia ''silnik z komutacją 

elektroniczną. 

Bezkomutatorowe silniki prądu stałego należą do grupy silników synchronicznych. Wobec 

tego pola wytwarzane przez uzwojenia stojana i magnesy trwałe osadzone na wirniku 

poruszają się z tymi samymi prędkościami. 

Sposób zasilania faz silnika zależy od sygnałów sterujących generowanych w oparciu o 

położenie wirnika. Ich zsynchronizowanie pozwala uzyskać stały moment i prędkość 

obrotową silnika. 

Zastąpienie komutatora mechanicznego elektronicznym ma wiele zalet. Brak szczotek na 

komutatorze oznacza brak wyładowań łukowych. Zmniejsza to zakłócenia radioelektryczne i 

pozwala stosować silniki w środowiskach wybuchowych. Zwiększa również bezawaryjność 

silnika i jego trwałość. 

Dzięki zastosowaniu komutatora elektronicznego można łatwo zmieniać charakterystyki 

silnika. Mimo, ze silnik BLDC jest silnikiem synchronicznym nie występuje w nim zjawisko 

utraty synchronizmu. Wynika to ze sposobu wytwarzania pola magnetycznego w stojanie. 

Jest ono wytwarzane w funkcji kąta położenia wirnika względem stojana, a więc jest 

samoczynnie zsynchronizowane z polem wirnika. 

W przypadku wystąpienia przeciążenia silnik po prostu zmniejsza swoja prędkość obrotową, 

podobnie jak silnik prądu stałego. 

Budowa silnika 

Silnik bezszczotkowy prądu stałego jest odpowiednikiem odwróconego konwencjonalnego 

silnika prądu stałego z magnesami trwałymi. 

W silniku bezszczotkowym prądu stałego wirnik zawierający magnesy stałe przemieszcza się 

względem uzwojeń umieszczonych w żłobkach stojana. 

Podobnie jak w wypadku konstrukcji konwencjonalnej, tutaj także prąd płynący w 

uzwojeniach musi zmieniać swoją biegunowość za każdym razem, gdy biegun wirnika minie 

uzwojenie danej fazy, aby zapewnić jednokierunkowość wytworzonego momentu. 



Tak, więc przepływ prądu i jego biegunowość musi być synchronizowana ze zmianą 

położenia wirnika. 

Większa liczba biegunów gwarantuje bardziej równomierne rozłożenie momentu 

napędowego, a mniejszy krok pozwala uzyskać większą moc przy małych prędkościach 

obrotowych. Poniżej przedstawiono przykładowe konstrukcje silników BLDC: 

 

Rys.1 Konstrukcje silników BLDC 

 

 

Rys.2 Konstrukcje silników BLDC 

 

 



Główne zalety silnika bezszczotkowego w porównaniu z innymi silnikami to: 

● bardzo duża sprawność, 

● liniowa charakterystyka mechaniczna, 

● wysoki stosunek momentu rozwijanego do gabarytów, 

● brak komutatora, 

● bardzo mała inercja wirnika. 

 

Rys.3 Idealizowana zależność prędkości obrotowej silnika bezszczotkowego prądu stałego 

od momentu obciążenia. 

 

Najprostszy układ zasilania silnika bezszczotkowego prądu stałego składa się z falownika 

(układu mostkowego kluczy tranzystorowych) realizującego sterowanie PWM, czujnika 

położenia wirnika i układu regulacji prędkości obrotowej (napięcia) i kontroli prądu 

zasilającego. 

 



 

 

Rys.4 Układ sterowania silnikiem BLDC. 

 

Podczas obrotu wirnika o 360° realizowanych jest kolejno kombinacja 6-ciu różnych stanów 

pracy (jednoczesnego załączenia) par tranzystorów (kluczy) układu mostkowego – K1,K2 ; 

K2,K3 ; K3,K6 ; K6,K5 ; K5,K4 oraz K4,K1. 

 

 



Dzięki zdolności regulacji prądu sterownik umożliwia dokonanie rozruchu silnika 

bezszczotkowego bez potrzeby stosowania specjalnych oporników rozruchowych. 

 

 

Rys.4 Charakterystyki mechaniczne i elektryczne silnika BLDC, odpowiednio: 

• prąd w funkcji momentu obciążenia, 

• prędkość obrotowa w funkcji momentu obciążenia, 

• sprawność silnika w funkcji momentu obciążenia. 

 

 

 

 

 



Celem niniejszego ćwiczenia jest opanowanie podstaw obsługi systemu z serwonapędem, a 

w szczególności: 

 uruchamianie serwonapędu 

 wykonanie ruchu referencyjnego 

 sterowanie prędkością 

 sterowanie pozycją 

 

Uruchamianie serwonapędu 

Aby prawidłowo i bezpiecznie użytkować układ konieczne jest zapoznanie się z aplikacją 

Wmemoc oraz początkowymi ustawieniami niezbędnymi do poprawnej pracy układu. 

Wprowadzenie 

W ćwiczeniu tym nauczysz się: 

 ustanawiać komunikację pomiędzy komputerem PC a modułem SEC-AC, 

 ustawiać opcje programu Wmemoc oraz wczytywać zestaw ustawień Festo, 

 przeprowadzić ręczne sprawdzenie sprzętu, 

 sprawdzać ustawienia okien dialogowych „Command” oraz „Reference Position”, 

 aktywować system serwonapędu. 

 

 

 Rysunek 1: Zmontowany układ serwonapędu z silnikiem besszczotkowym. 

 



 

Szczegółowe instrukcje. 

 

Zanim włączysz zasilanie sprawdź czy panel sterowania jest podłączony do kontrolera (nie 

uruchamiaj jeszcze aplikacji Wmemoc) 

Główny wyłącznik zasilania jest w pozycji OFF. 

Sprawdzenie panelu. 

 

Przełącznik  (Regler) jest wyłączony (pozycja w dół - OFF) – zielona dioda zgaszona. 

Wzmacniacz mocy mocy (Endst.) jest wyłączony (pozycja w dół - OFF) – zielona dioda 

zgaszona. Wszystkie inne przełączniki są wyłączone (pozycja w dół), a potencjometry są 

ustawione na pozycje zerowe. 

 

Rysunek 3: Panel sterowania 

 

Rysunek 2: Główny włącznik zasilania. 



 

Załączenie zasilania 

 

Element napędzany  powinien znajdować się w środkowym położeniu. 

 

Zasilanie załączamy zawsze w następującej kolejności: 

 napięcie główne (~230V), 

 napięcie pomocnicze 24V, 

 

Po przeprowadzeniu autotestu na przodzie modułu SEC-AC zaświeci się dioda READY. 

 

Uwaga :    Wyłączanie układu w odwrotnej kolejności 

 

Jeśli pojawią się komunikaty o błędach, popraw: 

Błąd   Procedura 

Error 2  Sprawdź zasilanie układu SEC-AC. Upewnij się że włączasz układy 

w odpowiedniej kolejności 

Error 3   Sprawdź połączenia silnika; kabel do serwonapędu. Jeśli to 

konieczne wyjmij go  podłącz ponownie. 

 

           

Ustanowienie komunikacji między PC a SEC-AC 

 

Uruchom program Wmemoc na komputerze PC (jeśli wystartujesz go wcześniej pojawi się 

komunikat błędu). Jeśli komunikacja działa to program Wmemoc uruchomi się z trzema 

otwartymi oknami – „Commands”, „Status” oraz „Actual Values”. 



 

Ustawianie opcji programu Wmemoc. 

Wybierz z głównego menu pozycję „Actual Values”. Zaznacz wszystkie opcje, co spowoduje 

ich aktywację w oknie „Actual Values”. 

 

Rysunek 5: Wybór wyświetlanych wielkości 

Rysunek 4: Okno aplikacji Wmemoc. 



Wybierz Options > User Mode > Expert. W ten sposób będziesz miał dostęp do wszystkich 

funkcji programu Wmemoc. 

 

Wczytanie zestawu ustawień. 

 

Wybierz Select File > Parameter Set > Read from file and store into servo. 

 

W oknie eksploratora znajdź odpowiedni zestaw parametrów. Powinieneś go znaleźć w 

katalogu  

C:\Programme\Festo\wmemoc\wpa\Motor\MTR-AC- 55\horizontal 

Wybierz zestaw parametrów odpowiedni dla silnika i modułu liniowego DGE, których 

używasz, upewniając się, że wybrałeś odpowiednią pozycję (poziomą – horizontal lub 

pionową - vertical) 

Uwaga: 

Rysunek 6: Wybór trybu pracy. 

Rysunek 7: Wczytanie zestawu ustawień. 



Wczytane parametry są automatycznie zapisywane w pamięci EEPROM, natomiast zmiany 

parametrów muszą zostać zapisane do EEPROM. 

 

 

Naciśnij OK i wczytaj zestaw parametrów. Pojawi się wskaźnik postępu wczytywania, które 

zajmie około 50s. Po zakończeniu ujrzysz komunikat „Data transferred”. 

 

Uwaga: 

Kontroler został właśnie zaopatrzony w kompletny zestaw predefiniowanych parametrów dla 

wszystkich kombinacji osie-serwonapędy firmy Festo (dla przypadku użycia poziomej i 

pionowej konfiguracji). Te predefiniowane parametry dają początkową, bezpieczną 

konfigurację sterownika.  

Rysunek 8: Wczytanie parametrów. 

Rysunek 9: Odczyt parametrów z pamięci EEPROM. 



Następnie pętle sterownika powinny zostać zoptymalizowane do konkretnej aplikacji. 

 

Zapisywanie zestawu parametrów 

 

Są dwie możliwości zapisania zestawu parametrów:  

Wybierz File > Parameter set > Read from servo and save into file. 

W ten sposób zapiszesz parametry z pamięci EEPROM modułu SEC-AC do pliku 

komputera. 

lub 

Wybierz  Parameters > Save parameters. 

 

W ten sposób zapiszesz dane z pamięci ulotnej RAM modułu SEC-AC do jego pamięci stałej 

EEPROM.  

Tylko w ten sposób zmiany parametrów pozostaną zapisane w przypadku awarii napięcia 

zasilania 24V. 

 

 

Ręczna kontrola sprzętu. 

 

Rysunek 10: Zapis parametrów. 



Sprawdź wartość w okienku „Position” poprzez poruszenie ręką suwaka w dowolnym 

kierunku, aż do osiągnięcia przełącznika krańcowego. 

Sprawdź czy licznik pozycji w oknie „Actual Values” zlicza pozycję w górę i w dół. 

 

Sprawdź funkcjonowanie wyłączników krańcowych. 

Jeśli licznik liczy w górę, kiedy osiągniesz wyłącznik krańcowy, w oknie „Status” powinna 

zaświecić się dioda obok tekstu „Limit switch 1”.  

Sprzwdź na poniższym rysunku. 

Sprawdź to samo w przeciwnym kierunku – licznik powinien odliczać w dół, a w oknie 

„Status” powinna zaświecić się dioda obok tekstu „Limit switch 0”. 

 

 

Rysunek 11: Licznik pozycji. 



 

Możliwe problemy 

 

Problem   Sposób rozwiązania 

Dioda wyłącznika krańcowego nie 

zapala się  po osiągnięciu pozycji 

końcowej 

Sprawdź  połączenia 

Sprawdź  funkcjonowanie wyłącznika krańcowego 

Sprawdź  logikę  wyłącznika krańcowego 

Sprawdź  czy na testerze przełączniki E0 i E1 są  w 

dolnej pozycji 

Kierunek zliczania nie zgadza się  

z numeracją  wyłącznika krań-

cowego (zlicz. w górę  do wył.1, 

zlicz. w dół do wył.0) 

Fizycznie zamień  wyłączniki krańcowe miejscami 

Kontrola bezpieczeństwa 

      

 

 

Rysunek 12: Okno statusu. 



Uaktywnienie systemu przy pomocy panelu sterowania. 

 

Przełącz końcówkę mocy (Endst.) do pozycji ON (zapali się dioda) 

Przełącz sterownik (Regler) do pozycji ON (zapali się dioda) 

Na 7-segmentowym wyświetlaczu modułu SEC-AC wyświetla się litera „P” (= tryb 

pozycjonowania) 

Zauważ, że suwak jest teraz zablokowany i nie może być przesuwany. Możesz teraz słyszeć 

hałas o wysokiej częstotliwości dochodzący z kontrolera. 

 

Sprawdzenie ustawień dla trybu pozycjonowania w oknie dialogowym „Commands” 

 

Otwórz okno dialogowe „Commands” i upewnij się, że następujące ustawienia są aktywne () 

 Drive enable 

 Motor speed control 

 Position control 

 Positioning 

Rysunek 13: Okno dialogowe 

„Commands”. 



 

Ruch referencyjny serwonapędu. 

 

Do prawidłowej pracy serwonapęd potrzebuje tzw. pozycji odniesienia, względem której 

liczone są wszystkie inne położenia.  

Pozycja odniesienia ustalana jest w ruchu referencyjnym po uruchomieniu a przed normalną 

pracą serwonapędu. 

Naciśnij ikonę ruchu referencyjnego, aby otworzyć okno dialogowe. 

W oknie dialogowym ruchu referencyjnego sprawdź, że zaznaczona jest opcja „Method 1” w 

polu „Mode”. Trzymaj jedną rękę na wyłączniku urządzenia SEC-AC aby w każdej chwili móc 

go wyłączyć, gdyby wystąpił jakiś błąd. 

 załącz Panel sterujący, 

 załącz kontroler, 

 uruchom ruch referencyjny, klikając w oknie dialogowym ruchu referencyjnego, 

Rysunek 14: Ikona ruchu referencyjnego. 

Rysunek 15: Okno ruchu referencyjnego. 



 przyciśnij przycisk „GO!” 

Suwak poruszy się do punktu referencyjnego a następnie zatrzyma. Jeśli system jest zbyt 

głośny lub ruch jest nierównomierny wyłącz kontroler i zgłoś błąd prowadzącemu zajęcia. 

 

Nastawianie pozycji, prędkości oraz nachyleń charakterystyk serwonapędu 

 

W ćwiczeniu tym nauczysz się 

Odczytać zestaw zdefiniowanych pozycji. 

Wybierać pozycje używając okna dialogowego „Go to Destination” (Idź do celu). 

Trzech sposobów poruszania pomiędzy poszczególnymi pozycjami. 

 

W polach okienek przyśpieszania („Acceleration”) oraz hamowania („Deceleration”) możesz 

sparametryzować nachylenia charakterystyk prędkości dla rozpędzania i hamowania 

napędu. Jeśli czasy w polu „Smoothing” zostaną ustawione na zero to nachylenia będą 

liniowe, w innym wypadku będą to funkcje paraboliczne. 

 

 

 

Rysunek 16: Przykładowy przebieg ruchu napędu. 



Sprawdzanie pozycji 

 

Uwaga: nie musisz wprowadzać pozycji – zestaw pozycji został wczytany jako część zbioru 

parametrów. W ćwiczeniach używasz predefiniowanych pozycji, prędkości i charakterystyk – 

niektóre z nich będziesz modyfikować. 

Naciśnij ikonę celu „Destination”. 

-Pojawi się okno dialogowe „Destination 0”. 

 

 

 

Rysunek 17: Ikona celu. 

Rysunek 18: Okno dialogowe pozycji. 

 

 

 

 



Poniższa tabela przedstawia pozycje zdefiniowane w zestawie wczytanym do kontrolera 

Nr pozycji Pozycja 

(R) 

Prędkość 

ruchu 

[obr/min] 

Tryb 

pozycjonow

ania* 

Czas 

przyśpieszenia 

[ms] 

Czas 

opóźnienia 

[ms] 

0 -0,5 100 Abs 400 400 

1 -4,3 200 Abs 100 100 

2 -4,3 300 Abs 100 100 

3 -4,3 400 Abs 100 100 

4 -4,3 500 Abs 100 100 

5 -1 200 Abs 400 400 

6 -2 250 Abs 400 400 

7 -3 300 Abs 400 400 

8 -4 400 Abs 400 400 

9 -4,3 500 Abs 400 400 

10 -4,3 500 Abs 100 100 

11 -0,5 300 Rel 400 400 

12 0,5 300 Rel 400 400 

 

SEC-AC wraz z innymi parametrami. Klikając na przyciski kolejnych pozycji możesz 

obejrzeć nastawy każdej z nich. 

*Zauważ, że tryb pozycjonowania („Positioning mode”) w aplikacji Wmemoc nosi nazwę 

„Positioning run”. 

 

 



Ruch do wybranej pozycji 

 

Włącz kontroler (Regler). 

Wybierz przycisk „Go to destination” na pasku narzędzi. 

Naciskając kolejne przyciski w oknie dialogowym możesz przesuwać napęd do zadanych 

pozycji. (Jeśli rozpoczynasz bezpośrednio po wykonaniu ruchu referencyjnego suwak 

powinien być w pozycji referencyjnej). 

 

Wybierz pozycje w kolejności przedstawionej w poniższej tabeli. Odznaczaj kolejne 

wykonane ruchy w kolumnie „Krok”, a w prawej kolumnie rób notatki ze swoich obserwacji 

ruchu suwaka. 

 

 

 

 

Rysunek 19: Ikona „Idź do celu”. 

 

Rysunek 20: Okno „Idź do celu”. 



Pytania kontrolne: 

 

 Budowa silnika bezszczotkowego  

 Zalety silnika bezszczotkowego 

 Przykładowe charakterystyki mechaniczne i elektryczne silnika BLDC 

 Schemat blokowy serwonapędu z silnikiem elektrycznym (z pętlami sprzężenia 

zwrotnego prędkościowego i położeniowego) 


